
 

 

 

 

 
 

 

Remote Monitoring and Control 
 
 
 

Remote Telemetry Module  
(RTM-GPRS)TM 

 
Users’ Guide 

 
9941 West Emerald Street 

Boise, ID 83704 

208-658-1292      FAX 208-323-5575 

support@telemetric.net 

 

 

v. 1.0 



Page 2 of 42 Telemetric RTM-GPRS Users’ Guide 



 Telemetric RTM-GPRS Users’ Guide Page 3 of 42 

Table of Contents 
 

Introduction _________________________________________________________________ 5 
RTM Overview _______________________________________________________________ 5 
Configurations________________________________________________________________ 5 
How it Works_________________________________________________________________ 5 
Getting Started _______________________________________________________________ 6 

Programming and Installing the RTM-GPRS ______________________________________ 7 
Programming the RTM ____________________________________________________________ 7 
Installing the RTM ________________________________________________________________ 7 

Testing the receiver strength (RSSI)_______________________________________________ 7 
LED Indications_______________________________________________________________ 9 
Connector pin specifications____________________________________________________ 11 

Using the Telemetric Web Site__________________________________________________ 12 
Setting up Your Account on the Web Site_____________________________________________ 12 

Logging In __________________________________________________________________ 12 
Entering Customer Information__________________________________________________ 12 
Entering Device-Specific Information _____________________________________________ 13 

Viewing, Monitoring and Controlling Data ___________________________________________ 15 
Request Data _______________________________________________________________ 15 
History Report_______________________________________________________________ 15 
Control Outputs______________________________________________________________ 15 
Advanced Commands_________________________________________________________ 16 
Analog Data Graphing ________________________________________________________ 18 

Device Groups ___________________________________________________________________ 18 
Group Setup ________________________________________________________________ 18 
Requesting Group Reports _____________________________________________________ 19 
Sending Group Commands ____________________________________________________ 19 
Display Only Groups__________________________________________________________ 20 

Event Based Actions ______________________________________________________________ 20 
Creating a new control action ___________________________________________________ 20 
Event-based user notifications __________________________________________________ 22 
Create a Message____________________________________________________________ 22 
Add a Recipient _____________________________________________________________ 23 
Recipient Distribution Lists _____________________________________________________ 24 
Setting Up a User Notification___________________________________________________ 24 
Global User Notifications ______________________________________________________ 26 
Groups in Event Based Actions _________________________________________________ 27 

Setting Up Data Export____________________________________________________________ 28 
Global data exporting _________________________________________________________ 28 
Device specific exporting ______________________________________________________ 28 
Email data export format_______________________________________________________ 28 

Advanced Programming___________________________________________________________ 29 
Acknowledgement Retries _____________________________________________________ 29 
Create/Edit User IDs__________________________________________________________ 30 
View Airtime Usage___________________________________________________________ 30 
Historic Graph Template Setup__________________________________________________ 31 



Page 4 of 42 Telemetric RTM-GPRS Users’ Guide 

Device Profiles ___________________________________________________________________ 31 
Customizing the Input and Output Labels__________________________________________ 31 

Appendix A:  Local Programming ______________________________________________ 32 
Creating a Custom Programming Profile _____________________________________________ 32 
Programming the RTM With the New Profile _________________________________________ 34 
Viewing the Current Profile of a Device ______________________________________________ 34 
Viewing the RSSI Reading _________________________________________________________ 35 
Viewing Present Values____________________________________________________________ 35 
Programming Multiple Address RTMs ______________________________________________ 36 

Appendix B: Point Specifications _______________________________________________ 37 
Rules ___________________________________________________________________________ 37 

Current Rule Types___________________________________________________________ 37 
Rule Configuration ___________________________________________________________ 38 
Non-Rule Configuration _______________________________________________________ 38 
Serial Port Configuration_______________________________________________________ 38 

Call Header Information __________________________________________________________ 38 
RTM Startup ____________________________________________________________________ 39 
Call Reasons_____________________________________________________________________ 39 
Remote Commands _______________________________________________________________ 40 

Appendix C:  Hardware Specifications___________________________________________ 41 
On-board RS232 serial ports ___________________________________________________ 41 
Antenna ___________________________________________________________________ 41 
On-Board Radio Signal Strength Indicator _________________________________________ 41 
Enclosure __________________________________________________________________ 41 
Cellular Radio Operating Specifications ___________________________________________ 41 
Internal AC / DC power supply __________________________________________________ 41 
CPU / Memory ______________________________________________________________ 42 
Environmental Specifications ___________________________________________________ 42 
Power Consumption, Nominal __________________________________________________ 42 
Power Consumption when Transmitting ___________________________________________ 42 
 

 
 
 
 

Revision Date  

1.0 2/2/06 Original Version 

   



 Telemetric RTM-GPRS Users’ Guide Page 5 of 42 

Introduction 
 

Telemetric monitoring and control devices provide a low cost wireless system for remote 
monitoring, measurement, data collection, and control of equipment or machinery anywhere in 
the North American cellular coverage area.  

The Telemetric system provides two-way communications using digital GPRS public cellular 
network. The low cost of this proprietary method makes remote monitoring and control very 
affordable. 

 
RTM Overview 
Most newer generation Remote Terminal Units (RTUs) and Intelligent Electronic Devices (IEDs) 
use the DNP3 communication protocol to communicate with utility SCADA systems. 
Communications with these IEDs has always been problematic if the device is located outside of 
the substation fence. Telemetric’s DNP-Remote Telemetry Module™ (DNP-RTM GPRS) provides 
an attractive solution for remote communications with DNP enabled devices. 

Telemetric’s RTM uses the cellular data network to enable communications between IEDs with 
supported protocols and the Telemetric Network Operations Center (NOC). When it receives data 
from the RTM, the Telemetric NOC immediately displays the data on the customer’s secure web 
page. Alternatively, the customer can use Telemetric’s DNP Scada-Xchange™ software, which 
uses a secure TCP/IP connection to transfer the DNP3 data directly to the utility’s SCADA 
system.  

The Telemetric RTM connects to an IED such as a digital protective relay, voltage regulator, or 
capacitor bank controller via an RS-232 serial port. The RTM can either be installed as a 
communications board within the IED enclosure, or externally in its own weatherproof enclosure. 

The new digital RTM line now offers support for multiple protocols: 

• Distributed Network Protocol (DNP3) 

• Multiple Address DNP3 

• 2179 

• Joslyn Smartlink 

 
Configurations 
Pre-configured RTM devices are currently available for a number of IEDs. Visit the following Web 
site to see the most recent list of supported IEDs: 

http://www.telemetric.net/ied/ 

More configurations are being added all the time, so watch the web site for updates. 

 

How it Works 
The RTM constantly polls the IED to get the most current data. When it discovers a reportable 
event, for example a binary input that has changed state, it initiates a call over the GPRS network 
to the Telemetric NOC. The cellular network automatically passes the module's identification 
numbers and data to the central cellular hub. This technique allows the transmission of an 
identification number, the time, the date, and all of the call data at a very low cost. At the 
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Telemetric NOC, the data is validated and processed for distribution to the end user. In addition, 
control and configuration information can be sent from the end user to the Telemetric NOC, and 
then back to the RTM. 

 

Getting Started 
Setting up an RTM is a three-step process. 

1. Attach the Telemetric unit to the IED via the serial port and apply power (+12 VDC). The 
Integration Guide gives complete instructions for installing the RTM. 

2. Use the Telemetric RTM Configurator application to program the Telemetric unit with your 
specific IED communication parameters.  

3. Set up the device information on the Telemetric web site (www.telemetric.net). 

This manual provides the information you need to get started.  It is divided into two sections: 

• Programming and installing the Telemetric device, and 

• Using the Telemetric web site. 



 Telemetric RTM-GPRS Users’ Guide Page 7 of 42 

Programming and Installing the RTM-GPRS 
 

Programming the RTM 

The Telemetric RTM arrives from the factory programmed with some default settings for your 
application. To change those settings, and to program the correct communication settings for 
your IED, you need to locally program the device by connecting it to a PC with a serial cable and 
using the Windows-based program that comes with the RTM. The two settings that most often 
need to be changed are the Baud Rate setting and the Master/Slave Address Settings. If these 
do not match the settings in the IED, communication between the two will be impossible. 

The Integration Guide that came with this user manual contains a list of all of the factory default 
settings and provides programming instructions for your specific application. 

Appendix A contains detailed instructions on using the local programming application to program 
the RTM. 

 

Installing the RTM 

The RTM can be purchased either as a communications module that is installed within the IED 
enclosure or pre-installed in its own weatherproof enclosure. Follow the instructions in the 
Integration Guide to install the RTM in your specific IED. 

 
Testing the receiver strength (RSSI) 
After selecting an installation location, it is a good idea to test the device’s ability to transmit and 
receive.  (The device must be connected to power and an antenna attached in order to carry out 
this test.) You can check the RSSI using the local configuration software, or by viewing an LED 
indication on the side of the RTM enclosure. 

 

Testing the receiver strength using the Configuration software 

1. If you have not already done so, run the setup for the Telemetric RTM Configuration 
Program. This software was shipped to you on a CD along with your Telemetric device(s). It 
can also be downloaded from the www.telemetric.net web site. 

2. Connect the RTM to your computer with a straight-through serial cable. 

3. Run the RTM Configurator program.  

4. When the program opens, go to View -> RSSI Test Loop Window.  After a few seconds, you 
will see a negative number displayed in the new window. This is the RSSI reading.  The 
blinking background color also indicates signal strength for ease of use when standing away 
from the PC. 

Screen Appearance Meaning 

Solid red Inadequate signal strength 

Slow red blink Marginal or weak signal strength 

Slow green blink Acceptable signal strength 

Fast green blink Good signal strength 

Solid green Excellent signal strength 
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Testing the receiver strength using the LEDs 

If you do not have a laptop available in the field to view the RSSI in the Configuration software, an 
LED on the side of the RTM enclosure can indicate a less exact RSSI reading. 

The LED next to the push-button on the side of the device indicates RSSI. To test the RSSI, 
press and hold the test button (see Figure 1).  The RTM will then read the RSSI from the radio. 
The signal strength is displayed using the following patterns: 

 

LED Appearance Meaning 

Solid red Inadequate signal strength 

Slow red blink Marginal or weak signal strength 

Slow green blink Acceptable signal strength 

Fast green blink Good signal strength 

Solid green Excellent signal strength 

 

In addition to the RSSI, this LED also indicates when pages are received by, and transmitted 
from, the RTM, as described below. 
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LED Indications 
(See Figure 1) 

• Radio Transmit LED 

Green for 2 
seconds The RTM is sending out a page to the web 

server. 

Red for 2 seconds The RTM is receiving a page from the web 
server. 

Just below the RSSI LED there are three other LEDs that provide information about RTM 
functions. In order, from top to bottom, they are: 

• RTM Status LED 

Blinking Green The RTM is functioning normally. This is a 
“heartbeat” LED.  

Off or On There is a serious internal problem with the 
RTM. Try disconnecting it from power and 
then powering it back up. If this LED remains 
off, contact Telemetric Technical Support. 

• Cell Coverage 

Solid Green The RTM radio has a stable connection with 
the cellular network. 

Blinking Green The RTM has reached its daily call limit.  The 
call limit can be reset from the web page. 

Off The RTM has lost (or not yet established) its 
cellular connection. 

• IED Communications 

Green Packets are being sent to the IED. 

Red A response is being received from the IED. 
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Figure 1: RTM 

 
 

 

 

Note: This equipment contains components that can be damaged by 
electrostatic discharge. To prevent unexpected operation or permanent 
damage, be sure to connect the ground lug to an earth ground and always 
touch the ground lug before touching any components inside the enclosure. 
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Connector pin specifications 
RS-232 Ports 

 

Pin Description 

1 Not Used 

2 Tx 

3 Rx 

4 Tied to 6 

5 Ground 

6 Tied to 4 

7 Tied to 8 

8 Tied to 7 

9 Not Used 

 

 

 

 

RJ-45 Port 

Pin Description 

1 Not Used 

2 Not Used 

3 Rx 

4 Tx 

5 Not Used 

6 Not Used 

7 Not Used 

8 Ground 

 

 

Terminal Block 

 

Pin Description 

1 Tx 

2 Rx 

3 Ground 
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Using the Telemetric Web Site 
 

The Telemetric web site, www.telemetric.net, provides access to the data from your Telemetric 
units 24 hours a day, seven days a week, from any computer that has access to the Internet.  
Use the site to set up all monitoring and control functions, to set up automatic event notifications, 
and to remotely control the equipment connected to the RTM. 

 

Setting up Your Account on the Web Site 

Logging In 
To log in to your secure account on the web site, click on the Customer Login link on the web 
site (www.telemetric.net).  On the login screen, enter the user name and password that were sent 
to you with your Telemetric device(s). 

When you click the Enter button the customer Welcome screen will be displayed. This screen 
displays the most recent critical events for your devices, and the navigation panel on the left side 
has links to all of the device data and device configuration screens. 

 

Entering Customer Information 
After logging in for the first time click on the Customer Information link.  This will take you to the 
Customer Information page where you can fill in your name and address and change your 
password to one that is easier for you to remember. 

While on the Customer Information page, take note of the following fields: 

• Time Zone Offset: This should be set to the number of hours difference between your local 
time zone and Eastern Standard Time. For example, if you’re on the east coast of the United 
States set it to zero, and if you’re in California set it to -3. After setting the Time Zone Offset, 
all device report times will be displayed for your local time zone. If you have devices that are 
in a different time zone, you also have the ability to set device time zones individually on the 
Device Info page. 

• Status Call Interval: This is the default interval in hours between status calls for your devices 
(a number between 1 and 240). The Status Call Interval allows the Missing Device Report to 
list any devices that did not call in when they should have. You should set the interval equal 
to or longer than the longest report interval being used by the RTM’s digital or analog inputs. 
If you have programmed your device not to make status calls, or if you do not plan to make 
use of the Missing Device Report, do not fill in this field. If you have some devices making 
status calls at different intervals, set up their call intervals individually in the Device Info 
screen (reached from the device Status page). 

• Additional Info field: Use this text box to enter a custom name for the device "Additional 
Info" field. The Additional Info field is a customer specified data field. It appears as the name 
of a column on the Device List. It can be used to categorize any device-specific data. For 
example, it could be used to save GPS coordinates for the device, or to record the device's 
location on the power grid. This data can then be used to sort the devices in the Device List. 

If you do not want to use this extra field, you do not need to edit this text box. 
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Entering Device-Specific Information 
After installing a new Telemetric device, you can enter that device’s configuration information on 
the web site.  To do this, go to the Welcome screen and click on the Device List link.  In the 
Device List table that is displayed, click on the Device ID of the new RTM.  The Status screen for 
that device is displayed. 
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Edit Device Info 

At the top of the Status screen, click on the Edit Device Info link.  This brings up a screen that 
allows you to enter a customized description for this device and the device’s location information.   

 
Fill in the appropriate information for this device. The Additional Info field can be used for any 
additional device data that may need to be saved for this device. For example, it could be used to 
save GPS coordinates for the device, or to record the device's location on the power grid. As 
explained previously, the title of this field can be changed by filling in the field on the Customer 
Information page. If this field has been named in the Customer Information page, the new name 
will be displayed here, in place of “Additional Info.” 

To set up the device for a specific time zone, enter the Time Zone Offset. This is used if the 
device is reporting from a different time zone than the default setting on the Customer Information 
page (see above). If the device is not in a different time zone, you do not need to change this 
setting. 

The Status Call Interval field should be filled in only if this device has a different status call 
interval from the default interval entered on the Customer Information page. This is the device's 
programmed interval between status calls (a number of hours between 1 and 240). The Status 
Call Interval allows the Missing Device Report to accurately list any devices that do not call in 
when they should. 

Click the Save Changes button after completing the Device Info information.  You will return to 
the Status screen. 
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Viewing, Monitoring and Controlling Data 

Once the Telemetric RTM is installed and turned on, it immediately begins to monitor the IED.  
Within a few seconds of an input changes state, the device makes a call over the cellular network 
and reports the change.  This data is immediately available on the Telemetric web site.  (Click the 
Refresh link to update your screen with any new data.) 

The control output points are also ready to be remotely controlled via the web site. 

To view the current status of the device inputs and outputs, choose the Device List link from the 
navigation panel. The Device List gives a quick overview of the status of each device.  It shows 
the date and time of the last call, and what that call reported. 

For complete information on a specific device, click on the Device ID in the Device List to go to 
the Status page for that device. 

The Status page shows the status of each enabled digital and analog input status point at the 
time of the last report.  It also displays the control output commands. 

 
Request Data 
From the Status screen you can request an updated status report from the device at any time.  To 
request a report, click the Request Data link at the top of the screen.  On the Request Data 
screen, select the report that you want to receive, such as All Analog and Digital Data, the time 
that you want to receive it (either now or at some point in the future), and click the Send button. A 
status request will be sent to the RTM, either immediately or at the requested time, and it will 
respond by sending back the requested information.  To see the updated data on the Status 
screen, click the Refresh link at the top of the page.  You can also go to the History screen and 
see that the Status Report has been received. 

Configuration and Maintenance reports do not contain any point data.  

 

History Report 
Another tool provided by the Status screen is the History report.  All calls made by the RTM are 
saved in the database.  The call type and date filters on the History report can be used to display 
all of these calls, only a certain type of call, or calls from a certain time period.  When you click 
the History link, the history screen displays all calls for the past two months.  Select an option 
from the Display History for drop-down list to display only a certain type of call. Select a Date 
Range to choose a different time period to view. 

For GPRS units, if a point has not changed since the last time it was reported, the data for that 
point will not be listed in that call.  This is to save space on the history report.  This is needed 
because of the increased data throughput available with this device. 

 

Control Outputs 
Select a command from the drop-down box on the Status screen (below the Digital Inputs table) 
and then click the Send Command button to remotely control the IED’s output points. All 
commands will result in an acknowledgement being sent from the RTM. You will be able to see 
any state change(s) in the points list on the Status screen, and in the call record on the History 
screen.  A state change will only be reported if there is a change event rule setup for that point. 
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Advanced Commands 
The Advanced Commands screen gives you access to some RTM configuration commands.  The 
five commands are:  

• Reset the call limit  

• Reset the device 

• Enable or disable a DNP point 

• Enable the Analog stair step feature 

• Disable the Analog stair step feature 

When you select the Advanced Commands link at the top of the Status page, you will see the 
following screen. 

 

 
Select one of the commands from the drop-down list and click Continue. 

 

Reset the Call Limit 

Resetting the call limit resets the RTM’s internal count of how many calls it has made today. By 
resetting this counter, you allow the RTM to continue making calls after its call limit has been 
reached. This may be useful for testing purposes when the RTM is making a large number of test 
calls. 

After you choose to reset the call limit, you will see a confirmation screen. Once you confirm the 
command, it will be immediately sent to the RTM and the call limit will be reset. 

 

Reset the Device 

The Reset command results in a warm restart of the RTM. After the reset, the RTM makes a 
Power On call to the web site.  The call count will be reset and status will be verified and 
refreshed.  This command causes no configuration changes or resets. 

 

Enable or Disable a DNP Data Point 

Enabling or disabling a DNP point determines whether or not the RTM should report data on that 
point. If you are receiving data that you do not need, you can disable the DNP point. Once it is 
disabled, the point will no longer appear on the Status screen, and the RTM will no longer report 
any data on the point. Conversely, enabling a DNP point will cause the RTM to begin reporting 
data on that point, and the new point will be displayed on the Status page. 
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If you have chosen to enable or disable a DNP point, you will see something similar to the 
following example screen. 

 

 
Select the points you want to enable and un-select the points that you want to disable. When you 
click Save Changes you will see a confirmation page. Once the change has been confirmed, the 
configuration commands will be sent to the device.  

Note:  When you enable a point, it will use the factory default settings for that point, or the 
default settings that have been programmed into it using the local configuration program. For 

example, if you enable an Analog input point and want to use the three Analog limits to trigger 
reports, you must set the values of those limits using the local configuration utility. See Appendix 
A for details on using the local configuration program. See the Integration Guide that came with 
your RTM for a list of all factory default settings.  

 

Enable or Disable the Analog Stair Step Feature 

This command turns on or off the use of Analog “stair step” set points. By default, the RTM has 
three set points available for each Analog input. When the analog value crosses one of those set 
points, the RTM calls in to report an analog range change. The stair step feature allows a “stair 
step” dead band interval to be used for the Analog set points. For example, if the interval is set to 
25, the Analog point will have to change by 25 or more to trigger an event.  

The stair step interval must be set in local programming for the individual Analog point. See 
Appendix A for instructions on locally programming the RTM. Once that interval has been 
programmed into the RTM, the stair step feature can then be remotely turned on or off from the 
web site (it can also be enabled locally in local programming). When the stair step feature is 
enabled, the stair step set points are used for any of the Analog inputs that have been 
programmed to use them. If no stair step interval has been programmed (i.e. the stair step 
interval is set to zero), the Analog input will continue using the normal Analog limit set points (if 
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any have been set up). When the stair step feature is disabled, all Analog inputs revert to using 
the normal Analog limit set points, if set, and any stair step intervals are ignored. 

 

Analog Data Graphing 
From the Status screen you can go to a graphing tool to graph all historically logged analog data 
for this RTM type.  To setup a template for this graph, look under Advanced Programming - 
Historic Graph Template Setup (RTM Only).  There are instructions for this later in the manual. 

To create a graph, click on Analog Graphs link.  Up to three Analog points can be selected and a 
date range specified.  The graph will display all of the data values that were reported by the RTM 
for these points.  Scaling is handled automatically. 

 

Device Groups 

In order to manage a number of similar devices, Device Groups can be created.  Groups can be 
used to: 

• Filter the device list for specific devices. 

• Assign to a sub-user to give them access to a limited group of devices. 

• Assign to an Event Based Action to apply that action to every device in the group. 

• Send report requests to multiple devices at once. 

• Send control actions to multiple devices at once. 

 

Group Setup 
To create a Group, select the Device Groups link in the navigation panel.  Choose Create New 
Group from the menu on top of the Device Groups list.   

 

 
Only similar devices can be grouped for control and report requests (DNP-RTM, T646, etc.)  
Choose the model type and click “Press to Continue”.  If DNP-RTM is chosen, the next screen will 
ask you to choose which DNP-RTM model the group is intended for (Cooper Form 6, SEL 351, 
etc.) 
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The next screen will show all Devices that match the model type.  Select which devices should go 
in the Group.  Give the Device Group a name and click “Save Changes”. 

 

 
 

Requesting Group Reports 
To request a report from all of the devices in a Group at once, go to the Device Groups page.  
Select the desired group and click on the Request Status link.  Choose the desired report to 
request from the drop down list.  All reports that are available to request from a device’s Status 
Page are available to request here.  Click on Request Report and the request will go out to all 
devices simultaneously. 

 

Sending Group Commands 
To send a command to all of the devices in a Group at once, go to the Device Groups page.  
Select the desired group and click on the Send Command link.  Choose the desired command to 
send from the drop down list.  All output commands that you can send from the device’s Status 
Page are available to send here.  It is also possible to send a group command to Reset the Call 
Limit, Enable/Disable RTM Points and Enable/Disable the Stairstep feature.  Click on Send 
Command and the command will go out to all devices simultaneously. 
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Display Only Groups 
Display Only groups can be used to create a group of multiple types of devices, such as TVM3s 
and TC012s or RTMs with different model types.  The group cannot be used to send commands 
or requests, but can be used to filter the device list and to assign to a sub-user to limit their 
access to specific devices.  To create a Display Only group, click Create New Group and Select 
Display Only Group from the drop down list of available models. 

All devices on the account will be available for adding to the list.  Select which devices should go 
in the Group.  Give the Device Group a name and click “Save Changes”. 

 

Event Based Actions 

The Telemetric web software allows the user to create scenarios that will automatically carry out 
a control action or send out a user notification.  For example, a rule might be created to specify “If 
Neutral Current reports ‘high’ then set Cap Bank to ‘Off’.”  Or a notification rule might be created 
so that “If Neutral Current reports ‘high’, then send a notification to the Regional Supervisor.”  
These rules can also be more complex so that up to five conditions must be met before the action 
takes place.  For example, “If temperature is over 80° and Fan 1 is on, turn on Fan 2.” 

To create these rules, the Telemetric Intelligent Web Server has a step-by-step interface that 
walks through the process.  Messages and recipients or recipient distribution lists must be set up 
prior to setting up new user notifications.  After logging in to the web site, select the Event Based 
Actions link from the navigation panel. 

On the Event Based Actions screen there will be a list of Control Actions or User Notifications 
that have already been created.  These can be edited at any time by clicking on the Description. 

 

Creating a new control action 
To create a new Control Action, click the Create New Control Action button.  

1. The first step of the process is the selection of a Device ID.  Select an ID number from the top 
drop-down list box.  This is the Telemetric device that will be triggering the Control Action. If 
you would like to trigger an action for the same device, leave the next box at “Same as 
Trigger Device”, otherwise choose the desired device for the action to be directed at.  Time 
based actions are not available for the RTM. 
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2. Click the Proceed button to view the Control Action setup page. The screen shot below 
shows the setup page for event-triggered actions. 

 
3. The first step of the Control Action creation process is to select from the drop-down box the 

initial input trigger for the Control Action.  Triggers available for the RTM include all digital 
input changes, analog input range change calls (could be and range or stairstep) or specific 
ranges. 

4. Next, decide whether multiple inputs are needed to define this rule. 

Specify the "And" radio button and select the second condition to specify that both conditions 
must be true in order for the action to be carried out.  For example, “If temperature is greater 
than 80° is True AND Air Conditioner is Off, then perform action.” 

Specify the "Or" radio button and select the second condition if only one of the conditions 
needs to be true in order for the action to take place.  For example, “If Alarm 1 is On OR 
Alarm 2 is On, then perform action.” 

Continue adding conditions as needed, up to a total of five. 

If no other conditions need to be added to the rule, leave the remaining selections in the 
Additional Triggers table checked as none. 

5. Next, select the action to be carried out, for example, Open Cap Bank.  All available output 
commands are selectable as the action.  In addition, reports can be requested. 

6. Finally, type a name for the control action into the text box at the bottom of the page and then 
click the Save Control Action button to complete the process. 

When the Control Action has been saved, it will appear in the Event Based Actions table.  Control 
Actions can be edited at any time by clicking on the description.  As soon as it has been created it 
is active.  Control Action can be disabled by unchecking the actions enabled checkbox.   
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Event-based user notifications 
User Notifications are created by selecting a Message to be sent to a Recipient when selected 
criteria are met. 

Before building your first User Notification you must create a Message and Recipient, or 
Recipients and a Recipient Distribution List, for use in your notification. 

To set up new Recipients and Messages, select the Messages & Recipients link from the 
navigation panel.  Select the Messages link to create a new message or the Recipients link to 
create a new recipient.  The Recipient Distribution List link will create a list of Recipients so 
that a single User Notification can send the same message to multiple recipients. 

Note:  All notification messages are sent using e-mail addresses. An Internet e-mail address can be 
used to send a regular e-mail message that will be sent to an e-mail inbox, or as a message to a 
pager or cell phone with the ability to receive text messages. 

 
Create a Message 
When you click the Messages link the Add/Modify Messages screen is displayed. 

 

 
To create a new message, select the Add New Message button. 

 

 
It is required that you fill in all three fields in this screen to create a message. Type in a name for 
the new message in the Message Name field.  This is the name that will appear in the list of 
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previously created messages.  Fill in the Message Subject.  This will appear in the Subject line if 
the message is sent via Internet e-mail.  Type a message of 80 characters or less into the 
Message Text field. You can also insert one or multiple variables into the message by putting 
your cursor in the appropriate spot and selecting a variable from the drop-down box. The variable 
is a placeholder that tells the software to insert the requested data from the NOC database into 
the message before it is sent. Using variables, one message can be created and used for a 
multiple devices, instead of having to make a separate message for each device. The variables 
currently available for RTMs are: 

� Unit ID 

� Device Description 

� Device Address 

� Event Date/Time 

� Additional Information field 

� Trigger Point Label 

� Trigger Point Value 

� Trigger Point Range 

A Trigger Point is the point that triggered the notification.  For instance, if a notification was 
triggered off of  “Current Phase A – Range Change” then the trigger point is Current Phase A.  
The Trigger Point Label is “Current Phase A”, the Trigger Point Value is the present value of 
Current Phase A and the Trigger Point Range is the present range of Current Phase A.  The 
trigger points can also be used for digital input points.  If Trigger Point Range is used for a digital 
input point it will show up as a blank. 

A sample message: 

Subj:  Device 5013 Status //Uses the variable Unit ID 

Body:  Device 5013 reports a point change. //Uses the variable Unit ID 

Current Phase A: 9.2  Range: Low //Uses the Trigger Points Label: Value Range 

When finished with the new message, click the Add Message button to save it. 

 
Add a Recipient 
To add a new message recipient, click on the Recipients button on the Messages and Recipients 
page. 

 
The drop-down box on this page lists previously created recipients.  Click the Add New 
Recipient button to add a new recipient to the list or select a Recipient from the drop down list 
and hit Modify Current Recipient to edit the entry. 
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Enter a name and an email address for this recipient.  As mentioned before, this e-mail address 
can be either an Internet e-mail address or a text pager or cell phone e-mail address. 

After entering the recipient information, click the Add Recipient button.  You will be returned to 
the setup page. 

 

Recipient Distribution Lists 
If you want to send email to more than one recipient, enter all of the recipients on the Recipients 
screen, and then select the Recipient Distribution List link from the Messages & Recipients 
menu. This allows you to select a number of recipients and group them together for notifications. 

 

 
Click on Add Distribution List.  Select the desired Recipients and name save the list.  The above 
list example will now be added to the bottom of available recipients as “List: Support”. 

 
Setting Up a User Notification  
To create an event-based User Notification, select the Event Based Actions link from the 
navigation panel. 

On the Event Based Actions page, there is a list of previously created Control Actions and User 
Notifications.  Click the New User Notification link at the top of the page to create a new event-
based user notification rule. 

1. The first step in the process is to select the Telemetric device ID number for the module that 
will trigger the User Notification. (You also have the option of creating a Global user 
notification. See the instructions below.) 
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After selecting the device, click Proceed to display the Setup User Notifications page. 

 

 
2. Select the first trigger to initiate a User Notification. (If you select Missing Device or 

Command Failure, the appearance of this page will change. See specific instructions for 
these options below.) 

3. Choose whether multiple inputs are needed to define this rule in the Additional Triggers table. 

Specify the And radio button and select the second condition to specify that both conditions 
must be true in order for the user notification to be sent.  For example, “If Cap Bank is Open 
AND SCADA Control is Local, then send Status Message to Joe.” 

Specify the Or radio button and select the second condition if only one of the conditions 
needs to be true in order for the action to take place.  For example, “If Alarm 1 is On OR 
Alarm 2 is On, send Alarm Message to Margaret.” 

Continue adding conditions as needed, up to a total of five. 

If no other conditions need to be added to the rule, leave the remaining selections in the 
Additional Triggers table checked as none. 
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4. Select the message that will be sent.  The messages in this drop down list box are those that 
were created on the Create Messages page. 

5. Select the message recipient or recipient distribution list.  The names that appear in this drop-
down box are the Recipients defined on the New Recipient page.  Any Recipient Distribution 
Lists you have created will be at the bottom of the drop down list.  Each Recipient is 
associated with an email address – either for Internet email or a text messaging. 

6. In the final step, give the User Notification a name and click the Save User Notification 
button to save it. 

The new User Notification will appear in the Event Based Actions list.  As soon as it has been 
created it is active.  User Notifications can be disabled by unchecking the actions enabled 
checkbox.  User Notifications can be edited at any time by clicking on the description.  The 
notification message will be sent to the recipient whenever the trigger event takes place.   

 

Global User Notifications 
You can create a global user notification that applies to all of your devices. Presently there are 
only three possible triggers for global user notifications: Missing Device, Command Failure and 
DNP Session Offline. These triggers are explained when selected. 

When the Global Notification option is selected, the User Notification screen that is displayed is 
slightly different. 

 
Select a global trigger from the drop down list and then fill in any necessary data. As with a 
normal user notification, you must select a message and a recipient or recipient list. Then give the 
user notification a name and save it. Once created, the global notification will be triggered by any 
of your devices, and new devices that are added to your web site will also be included in the 
global notification. 
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Command Failure Notification 

The command failure user notification will be triggered every time a command or data request is 
sent to a device and an acknowledgement is not received. If the device is set up to use 
Acknowledgement Retries (see the Advanced Programming menu), the command failure 
notification will not be sent out until all of the retries have failed. The software waits five minutes 
after the command is sent, or after the final retry is sent, before it sends out the command failure 
notification. 

Commands include any output change or programming command that is sent to a device. For the 
purposes of this notification, commands do NOT include report requests. 

 

Missing Device Notification 

The missing device user notification will be triggered when a device has not called in within a set 
period of time. This time period is specified when the user notification is set up. The time period 
used should be slightly longer that the period between Time Scheduled calls. When a device 
does not call in by the expected time, the user notification is sent out and the device also appears 
on the Missing Device Report, which can be reached from the navigation panel. 

If a global notification is created it will override any individual missing device user notifications 
that are created. 

 

Groups in Event Based Actions 
If there are multiple devices that require the same Control Action(s) or User Notification(s), the 
simplest way to do this is to use the Grouping function.  

 

Applying Device Groups 

Device Groups can be applied to User Notifications and Control Actions.  Setup the Event Based 
Action(s) desired for one of the devices.  A Group should be setup to include all of the devices 
intended to have the same Event Based Action(s), including the device used for the initial Event 
Based Action(s) setup.  On the Event Based Actions summary screen click on the “Assign” link 
for the action or notification to assign that action to a group.   

 
The Assign User Notification/Control Action to Group(s) page will be displayed.  All groups that 
the Device for which the Action was defined is a part of will be shown.  Any number of groups can 
be chosen.  Clicking “Assign to Group” will then apply that Event Based Action to any other 
devices in the groups assigned.  To unassign from a group, simply hit the “Assign” link again and 
unselect the group.  If no groups are selected, the Action reverts to its original Device Number. 
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Setting Up Data Export 

To export the data from one or more Telemetric devices for use in another data management 
program, set up the automated data export function. Currently the data export takes place in the 
form of machine-readable e-mail messages or CSV files (available for the TVM1 only). Other data 
export methods will be available in the future. 

To set up one or more devices for data export, select the Data Export Setup link in the 
navigation panel. 

Choose Global Export via E-Mail or Device-Specific Export via E-Mail. Global exporting 
exports all data for all devices that call in. Device Specific data exporting specifies one or more 
devices for data export. 

 

Global data exporting 
To use Global exporting, check the Enable Global Exporting check box and enter an email 
address into the Recipient Address text box. If you want data export email sent to more than 
one recipient, you can enter multiple email addresses separated by semicolons. Click the Update 
Global Settings button to save the changes. Once Global exporting has been enabled, each call 
from each device will generate an email message, which will be sent to the assigned email 
address. See the Email Data Export Format section, below, for details on how the data is 
formatted within the email. 

 

Device specific exporting 
To export data only for specific devices, select Device Specific Export via E-mail and click the 
Add Devices button. On the Add Devices screen, select a device from the drop down list, and 
then select an email recipient. The recipients in the drop down list are the Recipients and 
Recipient Lists that have been added on the Recipients page (reached by following the 
“Messages & Recipients” link in the navigation panel). 

After selecting a device and an email address, click the Save Selection button. A confirmation 
page will confirm the addition of the device, and the selected device and the e-mail address will 
be displayed in the Device Specific Exporting table. Follow this procedure for each device to be 
added. As soon as the device has been added to the table, each call from that device will 
generate an email containing the data from that call. See the Email Data Export Format section, 
below, for details on how the data is formatted within the email. 

 

Email data export format 
The export data within each email message is in a specific comma-delimited format, so that it can 
be imported directly into a database. The format is shown below, with the actual export data 
represented in brackets. Only the data that has been reported in the specific call will be sent in 
the e-mail, so only a small part of this list will be received each time. 

Unit, [Unit ID], 

Call Reason, [event that triggered the call], [date and time – mm/dd/yy hh:mm:ss] 

Serial Number, [Unit Serial No.], 

Input1, [current state], [date and time – mm/dd/yy hh:mm:ss] 

Input2, [current state], [date and time – mm/dd/yy hh:mm:ss] 

Input3, [current state], [date and time – mm/dd/yy hh:mm:ss] 
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And so on, for all digital input points… 

Output1, [current state], [date and time – mm/dd/yy hh:mm:ss] 

Output2, [current state], [date and time – mm/dd/yy hh:mm:ss] 

Output3, [current state], [date and time – mm/dd/yy hh:mm:ss] 

And so on, for all output points… 

Analog1, [current reading], [date and time – mm/dd/yy hh:mm:ss] 

Analog2, [current reading], [date and time – mm/dd/yy hh:mm:ss] 

Analog3, [current reading], [date and time – mm/dd/yy hh:mm:ss] 

And so on for all analog input points… 

 

Advanced Programming 

The Telemetric web site has an Advanced Programming section that gives you access to some of 
the more advanced features of the web site. Follow the Advanced Programming link on the 
navigation panel to find these tools. 

 

Acknowledgement Retries 
The Acknowledgement Retries feature allows you to set the number of retries used by the 
Telemetric software when a command is sent to a device. Whenever the device is sent a 
command, such as a command to open or close one of its outputs, it always sends back an 
acknowledgement so that the user knows that the command was successfully completed. By 
default, the Telemetric software does not re-send the command if it does not receive an 
acknowledgement from the device. By enabling automatic retries, the user is able to ensure that 
the device receives and responds to the command. 

To set Acknowledgement Retries: 

1. Select Acknowledgement Retries from the Advanced Programming screen. 

2. Select the device to program from the Device ID drop down list and click Continue. 

3. Select the number of retries (from 1 to 5) from the Number of times to Retry drop down 
list. 

4. Select the minutes and seconds for the system to wait before considering the call to have 
failed and to try again. 

5. Click the Continue button to save the new Acknowledgement Retries setting. You will see 
a screen telling you that the change has been made. From this point forward, the software 
will use the specified number of retries whenever it does not receive a command 
acknowledgement from the device. 

Note: With the use of retries, a very high level of reliability can be achieved for carrying out 
supervisory control commands. There are factors inherent in cellular communications, however, 
which prevent the system from being 100% reliable. If the device is having serious problems 
receiving messages, it may be unable to receive the command, no matter how many times it is 
retried. If the device receives and carries out the command, it may then have problems 
communicating the acknowledgement back to the web software. In this case, the software will 
send the command again. Receiving multiple commands may cause undesirable operation in 
some applications. The user should be aware of these limitations when using the Telemetric 
device for supervisory control applications. In addition, bear in mind that increasing the number of 
retries will increase the overall call volume. 
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Create/Edit User IDs 
This option allows a “master user” to create new user IDs that allow access to the Telemetric web 
site without having the ability to make edits or control the Telemetric devices. The “master user” is 
the initial user ID and password that is granted to you by Telemetric. Only the master user will 
see this item in the Advanced Programming menu. 

 

Creating a new User ID 

1. Select Create/Edit User ID from the Advanced Programming menu. 

2. Click the Add User ID button. 

3. Fill in the User ID and Password for the new user. For the User ID you must use 
alphanumeric characters only with no spaces or punctuation. The Password must be eight or 
more alphanumeric characters. 

4. Select either Operator, View and Report or View Only option. 

View Only:  This user type can only view the device and system data.  This user cannot send 
any report requests or control commands. 

View and Report:  This user can view all device data and request reports from devices. They 
cannot send control commands to devices.   This user can also request reports using any 
groups that they are authorized to use. 

Operator:  This user can view all device data, request reports from devices and send control 
commands to devices.  This user can also request reports and send commands using any 
groups that they are authorized to use. 

5. It is possible to limit a user to only seeing a particular group or groups of devices.  If this is 
desired, select the checkboxes next to the groups.  For a user to be able to see all devices 
and utilize all groups on the account, leave the groups section unchecked. 

6. Click Save Changes to save the new User ID. This User ID and password can now be used 
to access the web site. 

After creating a User ID, you can either edit or delete that ID by using the Edit and Delete buttons 
on the Create/Edit User IDs page. 

 

View Airtime Usage 
This option allows the user to view what call plans are setup for various devices, and to see how 
much of that call plan has been used.  To view Airtime usage, select View Airtime Usage from 
the Advanced Programming screen. 

Data is available for the current month as well as for previous months.  If a device is using a 
significant amount of its call plan, or is incurring overage bills, it is likely that the unit may need to 
be reprogrammed or checked out to reduce the number of calls.  Click on the unit number to bring 
up the Status Page for that unit.  The History for the device can be used to determine what is 
causing so many calls. 

Digital RTMs are billed by data usage.  To view this Airtime Usage, click on the GPRS Units 
Airtime Usage link at the top of the Airtime Usage page. 

If a device needs to have its call plan changed, contact Technical Support to check out the 
options. 
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Historic Graph Template Setup 
This option allows the Administrator to create a template for an RTM model type (i.e. Cooper 
Form 6) in order to specify which analog points will be logged for graphing.   

 

Creating a New Device Template 

1. Click Historic Graph Template Setup (RTM Only) from the Advanced Programming screen. 

2. Click the Create Graph Template link at the top of the screen. 

3. Select the Desired Model Type from the drop down list of available RTM Models and click 
Continue. 

4. A screen will come up with all of the analog points defined for that Model.  The points are all 
selected by default.  Modify the selection until only the analog points that should be logged 
are selected. 

5. Name the template and click Continue. 

 

Device Profiles 

You can customize the labels for all of the IED points and for their open and closed states by 
creating a Profile. To do this, click on Device Profiles in the navigation panel. 

 

Customizing the Input and Output Labels 
1. Click on Create Profile at the top of the Device Profiles screen. 

2. Select the DNP-RTM radio button and select the correct IED integration from the drop-down 
list. 

3. On the next page give the profile a name and then click Continue. 

4. On the following page all of the labels for the IED are displayed. Change any label you would 
like by just typing the new label into the text box. When you are finished, click Continue. 

5. The next screen will ask if you want to go ahead and assign devices to this profile. Select 
"Yes" and click Continue. 

6. You can choose to use this profile for all RTMs with this IED configuration by selecting the 
first check box. If you would rather assign devices to this profile individually, use the check 
boxes below under “Unassigned devices.” Click Save this Assignment to complete the 
process. 

Once the profile has been assigned, it will control all labels for the assigned RTMs. Any change to 
the profile will change all RTMs assigned to it. 
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Appendix A:  Local Programming 
 
The RTM includes a local programming application that runs on a PC or laptop. This program includes 
default profiles for each supported application. You can start with the default profile and customize it with 
your own preferred values. The following instructions tell you how to create a custom programming profile 
and then connect the RTM to the PC and program it with the new profile. 

 

Creating a Custom Programming Profile 

1. If you have not already done so, run the setup for the Telemetric RTM Configurator Program. This 
software was shipped to you along with your Telemetric device(s). It can also be downloaded from 
the www.telemetric.net web site. 

2. Run the Configurator Program.  

3. When the program opens, you will see the following screen. 
 

 
 

4. To open a profile for the RTM, select Open profile from the File menu. 
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Navigate the Profiles director to select the desired product. Select the “default” profile for an Analog 
DNP-RTM device and the “default-GPRS” profile for a Digital RTM-GPRS device.  Click Open. The 
profile is loaded into the display tabs. 

5. To change point settings, select the correct section (Digital Inputs, Digital Outputs or Analog Inputs) 
and then double-click on the point that you want to change.  
Digital Inputs 

• Enable or disable the point 

• Select whether you want it to report when the point changes state 

• Set the trigger time for the report (i.e. how long the state change must last in order to be 
reported) 

• Set the time scheduled report interval.  All digital inputs have the same time scheduled report 
interval, so if you change it for one point, it will change for all points.  (For analog devices, the 
time scheduled reporting interval must be done in hours.  For digital devices, the time 
scheduled reporting interval is in terms of minutes.) 

Digital Outputs 

• Enable or disable the point. 

Analog Inputs 

• Enable or disable the point 

• Select whether you want it to report when the point crosses a limit 

• Set the trigger time for the report (i.e. how long the range change must last in order to be 
reported)  

• Set the time scheduled report interval  (For analog devices, the time scheduled reporting 
interval must be done in hours.  For digital devices, the time scheduled reporting interval is in 
terms of minutes.) 

• Enter up to three limits for the analog reporting ranges 
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• Set up a stair step interval for the analog ranges. Note that you must enable stair step limits 
on the Configuration tab, or enable them from the web site, in order for this interval to be 
used. See the explanation below and in the Advanced Commands section of this manual.  

6. On the Configuration tab you need to select the communications settings for the IED and for radio 
communications. Select the settings that are appropriate for your application. The two settings that 
most often need to be changed are the Baud Rate setting and the Master/Slave Settings. If these 
do not match the settings in the IED, communication between the two will be impossible. 

As mentioned above, the Configuration tab also has the Stair Step Analog Limits setting. This turns 
on or off the use of Analog “stair step” setpoints. By default, the RTM has three setpoints available for 
each Analog input. When the analog value crosses one of those set points, the RTM calls in to report 
an analog range change. The Stair Step feature allows a dead band interval to be used for Analog 
setpoints. For example, if the interval is set to 25, the Analog point must change by 25 or more to call 
in with a Stair Step change. Once that interval has been programmed into the RTM, the Stair Step 
feature can then be enabled by checking this check box, or remotely turned on or off from the web 
site. When the Stair Step feature is enabled, the stair step setpoints are used for any of the Analog 
inputs that have been programmed to use them. If no stair step interval has been programmed (i.e. 
the stair step interval is set to zero), the Analog input will continue using the normal Analog set points 
(if any have been set up). When the Stair Step feature is disabled, all Analog inputs revert to using 
the normal Analog setpoints, if set, and any stair step intervals are ignored. 

7. When you have finished configuring all of the values, select Save profile as from the File menu. You 
cannot save changes directly to the Default profile, but you can save your profile with a new name. 
After saving the profile, you can program a RTM with the new profile. 

 

Programming the RTM With the New Profile 

Follow the instructions below to upload the profile you have created into the memory of the RTM. 

1. Use a serial cable to connect the Telemetric device to the PC COM port. (This must be the PC that is 
running the RTM Configurator Program.) Plug the serial cable into the top COM port on the RTM. 

2. If it is not already running, start up the RTM Configurator program. If it is not already open, open the 
profile you want to use for programming by selecting Open profile from the File menu. 

3. Select Send Profile to RTM from the File menu.  

4. The interface will switch to the Transfer Status tab and will show the progress of the upload. If an 
error message is displayed, the program is unable to establish communication with the RTM on the 
selected COM port. Make sure the cable is correctly connected, that you have selected the correct 
COM port (select COM Serial Port from the File menu to change the COM port setting), and that no 
other software programs have the COM port locked. 

When the process is complete, you will see a “Transfer Complete” message at the bottom of the 
Transfer Status tab. 

 

Viewing the Current Profile of a Device 

To see the current programming profile of a RTM, you can download and display its current settings. With 
the RTM connected to the PC, select Retrieve Profile from RTM from the File menu. The interface will 
switch to the Transfer Status tab and display the progress of the download. When the download is 
complete, the program will switch back to the Digital Inputs tab so that you can view the profile. If you 
want to save this profile, select Save profile as from the File menu. You will have the opportunity to give 
the profile a new name. 
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Viewing the RSSI Reading 

After selecting an installation location, it is a good idea to test the device’s ability to transmit and receive.  
(The device must be connected to power and an antenna attached in order to carry out this test.) You can 
use the local configuration software to check the RSSI. 

1. If you have not already done so, run the setup for the Telemetric DNP-RTM Configuration Program. 
This software was shipped to you on a CD along with your Telemetric device(s). It can also be 
downloaded from the www.telemetric.net web site. 

2. Connect the RTM to your computer with a straight-through serial cable. 

3. Run the Configurator Program.  

4. When the program opens, go to View -> RSSI Test Loop Window.  After a few seconds, you will see 
a negative number displayed in the new window. This is the RSSI reading.  The blinking background 
color also indicates signal strength for ease of use when standing away from the PC. 

Screen Appearance Meaning 

Solid red Inadequate signal strength 

Slow red blink Marginal or weak signal strength 

Slow green blink Acceptable signal strength 

Fast green blink Good signal strength 

Solid green Excellent signal strength 

 

 
 

 

Viewing Present Values 

To see the present RTM status points value, select View Present Point Values from the View menu. On 
the View Present Values screen that displays, click the Get Points button. The current values for all 
points will be displayed. The digital input point values will be displayed as zero or one with the appropriate 
value label next to it.  The scaled analog point values will be displayed next to their raw values. 
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Programming Multiple Address RTMs 

If you have purchased a Multiple Address RTM, the profile’s can be setup using the RTM Configurator 
software, with the following steps.  The order that the models are added to the profile will determine which 
IED corresponds with which session.  Multiple of the same profiles can be used or profiles can be mixed 
as needed. 

1. Go to File – Open Profile.  Select the folder of the first desired IED.  (This will be Session 0.)  
Inside the folder, select the default-GPRS file and click Open. 

2. Go to IED – Add to add the next desired IED.  Expand the appropriate folder and select the 
default-GPRS file and click Select.  Continue this step until all desired IEDs have been added.  
Up to five IEDs can be loaded to an RTM-GPRS MA device. 

3. As with standard RTMs, use the RTM Configuration window to program Polling Intervals, Call 
Limit, DNP Master Address, and Baud Rate information.  Remember that all devices must be 
programmed to use the same Baud Rate and DNP Master Address. 

4. Go to the IED Configuration window for each session and set the correct DNP Slave Address.  
The unique DNP Slave addresses will link the correct IED with its RTM Session. 

5. Setup any desired rule information for the Digital Inputs, Digital Outputs and Analog Inputs of 
each session.  Rule information must be setup for each session.  Rules for one session will not 
transfer to other sessions. 

6. Save the profile under File – Save Profile As.  You may choose where to save this profile.  You 
may wish to create a unique folder for the profile if it is a mixture of multiple IED types. 

7. Send the profile to the RTM under File – Send Profile to RTM. 
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Appendix B: Point Specifications 
 

 

Rules 

The RTM is built around the concept of "rules".  These rules are used to monitor points and test the data 
against a set of conditions.  If the conditions of the rules match, an action is triggered.   

The RTM polls the attached IED using Class 0 and Class 1,2,3,0 polls every N seconds (user 
configurable).   

 
Current Rule Types 

• Binary Change Event:  A rule monitoring a binary input point (value 0 or 1).  If the monitored point 
changes, the value is reported.  The initial condition is read when the RTM is powered up.  The 
rule may have a trigger time such that if the point changes for N seconds, the value is reported, 
but if it changes for less than N seconds it is not.   

• Analog Range Change Event:  A rule monitoring an analog input point.  If the monitored point 
crosses one of three possible limits, the value is reported, along with the range that the new value 
falls in.  The initial condition is read when the RTM is powered up.  The rule may have a trigger 
time such that if the point changes for N seconds, the value is reported, but if the change lasts for 
less than N seconds it is not.  An analog point can be setup for range change and/or stairstep 
change events.  If the Stairstep feature is Enabled, either from the local programming utility or 
from the Advanced Commands link on the RTM’s Status page, then a point with both range 
change and stairstep limits will only report stairstep events. 

• Analog Stairstep Change Event:  A rule monitoring an analog input point.  If the monitored point 
changes by the stairstep (deadband) setting or more, the value is reported.  The initial condition is 
read when the RTM is powered up.  The rule may have a trigger time such that if the point 
changes for N seconds, the value is reported, but if the change lasts for less than N seconds it is 
not.  An analog point can be setup for range change and/or stairstep change events.  The 
stairstep change event will only be processed if the Stairstep feature is Enabled, either from the 
local programming utility or from the Advanced Commands link on the RTM’s Status page. 

• Time Scheduled Report:  Each data point has the option of being reported at an interval of N 
minutes (0 <= N <= 65535).  The current value of the monitored point will be reported at the 
specified time interval.   

There are currently 99 rules available, numbered 1 through 99 (rule 0 is reserved).  Each rule can monitor 
a single point: DI, DO or AI.  When the rule is triggered, the current value of the point is reported.  For 
example, consider a binary input point with an initial value of 0.  Assume the RTM (the Master) reads the 
incoming value for the binary input, which now shows a value of 1. The RTM sees the change and sees 
that this is a reportable event, based on the defined rule for this point. As a result, the RTM reports the 
new value for this point to the Telemetric Network Operation Center (NOC).  

Rules are used to monitor both binary and analog input points.  A rule may also be used to control a 
binary output. In this case, a command sent from the NOC, or from the local programming utility will 
cause the RTM to write a 1 or 0 to that binary output point.  Analog outputs and counter inputs are not 
supported in this version of the RTM. 
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Rule Configuration 
The following rule information can be configured into the RTM by using the local programming utility 
included with the RTM. 

• Rule Enable/Disable 

• Up to three Analog Limits (analog rules) and/or a Stairstep Interval per analog input 

• Time Scheduled Reporting Interval 

• Trigger Time 

The rule enable/disable configuration can also be carried out from the Telemetric web site. When a rule is 
disabled, a trigger will not be reported and time scheduled reports will be disabled.  The point data will not 
be included in any All Data requests or shown on the Status page.  The customer will be prevented by the 
web site from requesting the current value of a disabled rule.   

If a rule is disabled/enabled via the local configuration utility, the RTM will notify the web site with a 
configuration call. 

 

Non-Rule Configuration 
The following are non-rule related user configurable information. They can be changed using the local 
programming software application. 

• DNP serial port settings (default 9600 N,8,1) 

• DNP Master, Slave addresses (default 1, 1) 

• Class 0 polling interval (default 30 seconds) 

• Class 123 polling interval (default 10 seconds) 

• Enable/Disable Stair Step Analog Limits (default Disabled) 

• Daily call limit (default 50) 

• Cellular Channel (N/A for digital devices) 

 

Serial Port Configuration 
The serial port has a number of possible configurations to allow communication between the RTM and 
the IED. 

• Baud Rates (110, 150, 300, 600, 1200, 2400, 4800, 9600, 19200, 31250, 38400, 115200) 

• Parity (even, odd, none) 

• Data Bits (8, 7) 

• Stop Bits (1, 2) 

 

Call Header Information 

All calls include the following information, along with specific information in the triggered report: 

• Firmware version 

• Hardware version 

• RTM Profile loaded 
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• Cellular IMSI number, for verification 

• Cellular Received Signal Strength Indicator (RSSI) 

• RTM Status Bits 

• Number of cell tower transmission attempts 

• Calls Left today 

 

RTM Startup 

On startup, the RTM will send a registration call containing all enabled point data, if the session is online, 
or a maintenance call if the session is offline.  The first call from the RTM is labeled a Power On call, 
regardless of what type of report it contains. 

 

Call Reasons 

The RTM will call for the following reasons: 

• Analog Range Change Report:  An analog point has crossed one of the three possible range 
limits for an amount of time longer than the trigger time.  (It is not necessary to use all three 
analog ranges.)  The new value and the new range are reported. 

• Command ACK Report:  A command Acknowledgement will be sent back to the NOC to report 
the successful completion of a binary output command, or any of the commands on the Advanced 
Commands menu. 

• Command NAK Report:  A command Not Acknowledged will be sent back to the NOC to report 
the unsuccessful completion of a binary output command, or any of the commands on the 
Advanced Commands menu.  This command will also be used on any other command that has 
failed, such as a Point Status request when the session is offline.  This report includes an error 
description. 

• Configuration Report:  Whenever the RTM’s configuration has been changed via the local 
configuration program, the RTM will report the change to the NOC. This report can be requested 
from the web site. 

• Current Value Report:  This report is in response to an individual point’s status request from the 
website. 

• Maintenance Report:  In the call of the Call Limit being Exceeded or the DNP Session going 
online or offline, or in response to a Maintenance Report request from the website, the RTM will 
make a Maintenance call to report the event. Call Limit Reached means that the RTM has 
exceeded its call limit for the day and will no longer report triggered events (it will still reply to 
requests). DNP Session Offline means that the RTM is not communicating with the IED. This 
usually indicates a serial cable problem or an incorrect setting for the IED master/slave addresses 
or baud rate. 

• Multiple Point Change Report:  If a DNP digital point is set up with a trigger time of zero, and the 
IED reports a change on that point using DNP Object 2, Variation 2, then the RTM will report any 
change (or multiple changes) on that point using this call.  The call supports multiple changes per 
point and reports the time of each change.  (Only available in firmware 6.2 and above for DNP 
protocols.) 

• Point Change Report: On system startup, the RTM will record the first value of each binary and 
analog point. If a binary point changes for an amount of time longer than the trigger time, the new 
value will be reported.  This report is also used for an analog point that is set up with a Stair Step 
limit that experiences an event for longer than the trigger time. 
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• Point Status Report:  On power-on, or receipt of an All Analog and/or All Digital request from the 
website, the RTM will transmit the current status of all enabled digital or analog points.   

• Time Scheduled Report:  Each data point may have a time scheduled report frequency measured 
in minutes.  Every N minutes, the current value of the point will be reported.  Digital Input points 
will be reported together.  

 

Remote Commands 

Remote commands are commands that can be sent from the Web Application. 

• Set Output Command:  This command will send an enable or disable command to a Digital 
Output point, as setup in the RTM profile.  The RTM will respond with a Command ACK indicating 
that the IED accepted the command or a Command NAK indicating that there was a problem with 
the command, and an accompanying error code.   

• Request All Analog and All Digital Data:  The user may request the current value of all enabled 
Digital and Analog points.  The RTM will respond with a Point Status Report. 

• Request individual Analog Point:  The user may request the value of a specific analog point.  The 
RTM will respond with a Current Value Report. 

• Request a Configuration Report:  The user can request this data if the unit failed to call in with a 
Configuration Report after a new configuration was loaded to the unit. 

• Reset the Daily Call Limit:  The user may request the RTM to reset its daily call limit when it is 
exceeded so that events will not be missed.  The RTM will respond with a Command ACK report.  
The call limit automatically resets ever 24 hours. 

• Enable/Disable Rule:  Each rule may be enabled or disabled by a remote command from the web 
site.  This feature allows the user to create a large rule set containing many contingencies or 
conditions and then enable or disable those rules after the device has been deployed.  A good 
example would be seasonally affected rules.  The RTM will respond with a Command ACK 
reporting the new status of the rule (on or off).   

• Enable/Disable the Analog Stair Step feature:  This command turns on or off the use of Analog 
“stair step” set points. By default, the RTM has three set points available for each Analog input. 
When the analog value crosses one of those set points, the RTM calls in to report an analog 
range change. The stair step feature allows a “stair step” dead band interval to be used for 
Analog set points. For example, if the interval was set to 25, the Analog point would have to 
change by 25 or more to trigger an event. The stair step interval must be set in local programming 
for the individual Analog point. 

• Reset the Device:  The user can send this command that is similar to power cycling the RTM.  
The RTM will respond with a Power On call. 
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Appendix C:  Hardware Specifications 
 
On-board RS232 serial ports 
Serial Port 1 

Connects the RTM to an intelligent electronic device (IED). 

Serial Port 2 

Connects directly with the serial port of a laptop or desktop computer to facilitate system configuration, 
installation and test.  

The specification for this serial cable connection is DB9M to DB9F with pin-outs 2-2, 3-3, 5-5. 

 
Antenna 
A dual-band Phantom Low-Profile antenna is included in the RTM integration kit. An external SMA 
connector provides the connection to this antenna or to a remote antenna if desired. Higher gain 
antennas including dual-band Yagi or panel models can be used to improve performance in fringe areas. 

 

On-Board Radio Signal Strength Indicator 
A pushbutton switch initiates a test in which an LED is used to indicate the radio signal strength being 
received by the radio. This is used to facilitate installation, antenna selection, orientation, and 
troubleshooting. The LED also provides a momentary indication for each transmission and other LEDs 
provide other troubleshooting indications. 

 

Enclosure 
If the RTM is ordered with an enclosure, the standard enclosure is a Nema 4 waterproof non-metallic box.  

 

Cellular Radio Operating Specifications 
The Multitech MTSMC cellular modem module has the following specifications: 

• 0.6 and 1.2 Watt transmit power at 850/1900 MHz. 

• Receive frequency: 850/1900 MHz,  

• Compatible with the GPRS digital cellular system  

 
Internal AC / DC power supply  
The standard DNP-RTM operates from 12 VDC ± 10%. Ripple must be less than 200 mV. Power 
consumption is nominally 100 mA and up to 2 Amps for 3 seconds when transmitting. 

The optional AC/DC power supply operates from 85-264 VAC, 47-440 Hz. 
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CPU / Memory  
The CPU is a Hitachi H8S series product. Non-volatile memory is used to store configuration and 
operational data.  

 
Environmental Specifications 
The recommended operating temperature range is -40 to +158 degrees F (-40 to +70 C). 

The recommended relative humidity range is 5 - 95% non-condensing. 

The RTM has been tested to meet the ANSI/IEEE C37.90.1-2002 specification - IEEE Standard Surge 
Withstand Capability (SWC) Tests for Protective Relays and Relay Systems. 

 

Power Consumption, Nominal 
90mA @ 12 VDC 

 

Power Consumption when Transmitting 
1.4 Amps @ 12 VDC 

 


